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Welcome 
Congratulations on purchasing the Verizon Wireless BroadbandAccess/NationalAccess V640 ExpressCard with 
VZAccess Manager.  This dual-band card operates over the CDMA EV-DO networks in the 800/1900 bands. This 
wireless ExpressCard will enable you to connect at high speed to the Internet, your corporate Intranet, and your 
email while you're away from the office.  This manual will provide information needed to get started and use your new 
V640 ExpressCard and VZAccess Manager.  

Wireless communications 
Important Notice 
Due to the transmission and reception properties of wireless communications, data can occasionally be lost or 
delayed.  This can be due to the variation in radio signal strength that results from changes in the characteristics of 
the radio transmission path.  Although data loss is rare, the environment where you operate the modem may 
adversely affect communications. 

Variations in radio signal strength are referred to as fading.  Fading is caused by several different factors including 
signal reflection, the ionosphere, and interference from other radio channels.  

Verizon Wireless or its partners will not be held responsible for damages of any kind resulting from the delays or 
errors in data transmitted or received with the V640 ExpressCard, or failure of the V640 ExpressCard to transmit or 
receive such data. 

Safety hazards 
Do not operate the V640 ExpressCard in an environment that may be susceptible to radio interference resulting in 
danger specifically; 

Areas where prohibited by the law 
o Follow any special rules and regulations and obey all signs and notices. Always turn off the host device 

and remove the modem from the card slot when instructed to do so, or when you suspect that it may 
cause interference or danger. 

Where explosive atmospheres may be present 
o Do not operate your modem in any area where a potentially explosive atmosphere may exist. Sparks in 

such areas could cause an explosion or fire resulting in bodily injury or even death. Be aware and 
comply with all signs and instructions. 

o Users are advised not to operate the modem while at a refueling point or service station. Users are 
reminded to observe restrictions on the use of radio equipment in fuel depots (fuel storage and 
distribution areas), chemical plants or where blasting operations are in progress. 

o Areas with a potentially explosive atmosphere are often but not always clearly marked. Potential 
locations can include gas stations, below deck on boats, chemical transfer or storage facilities, vehicles 
using liquefied petroleum gas (such as propane or butane), areas where the air contains chemicals or 
particles, such as grain, dust or metal powders, and any other area where you would normally be 
advised to turn off your vehicle engine. 

Near Medical and life support equipment 
o Do not operate your modem in any area where medical equipment, life support equipment, or near any 

equipment that may be susceptible to any form of radio interference. In such areas, the host 
communications device must be turned off. The modem may transmit signals that could interfere with 
this equipment. 

On an aircraft, either on the ground or airborne 
o In addition to FAA requirements, many airline regulations state that you must suspend wireless 

operations before boarding an airplane. Please ensure that the host device is turned off and your modem 
is removed from the card slot prior to boarding aircraft in order to comply with these regulations. The 
modem can transmit signals that could interfere with various onboard systems and controls. 
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While operating a vehicle 
o The driver or operator of any vehicle should not operate a wireless data device while in control of a 

vehicle. Doing so will detract from the driver or operator's control and operation of that vehicle. In some 
countries, operating such communications devices while in control of a vehicle is an offence. 

Limitation of liability 
The information contained in this document is subject to change without notice and should not be construed as a 
commitment by Verizon Wireless Inc.  

Copyright 
©2006 Verizon Wireless, Inc. 

Patents and licenses 
Licensed by QUALCOMM Incorporated under one or more of the following Patents: 

4,901,307 5,490,165 5,056,109 5,504,773 5,101,501 
5,506,865 5,109,390 5,511,073 5,228,054 5,535,239 
5,267,261 5,544,196 5,267,262 5,568,483 5,337,338 
5,600,754 5,414,796 5,657,420 5,416,797 5,659,569 
5,710,784 5,778,338 

Software Drivers License 
Proprietary Rights Provisions:  

The software drivers provided with this product are copyrighted by Verizon Wireless and/or Verizon Wireless’ 
suppliers.  And although copyrighted, the software drivers are unpublished and embody valuable trade secrets 
proprietary to Verizon Wireless and/or Verizon Wireless’ suppliers.  The disassembly, decompilation, and/or Reverse 
Engineering of the software drivers for any purpose is strictly prohibited by international law.  The copying of the 
software drivers, except for a reasonable number of back-up copies is strictly prohibited by international law.  It is 
forbidden by international law to provide access to the software drivers to any person for any purpose other than 
processing the internal data for the intended use of the software drivers. 

U.S. Government Restricted Rights Clause: 

The software drivers are classified as "Commercial Computer Software" and the U.S. Government is acquiring only 
"Restricted Rights" in the software drivers and their Documentation. 

U.S. Government Export Administration Act Compliance Clause: 

It is forbidden by US law to export, license or otherwise transfer the software drivers or Derivative Works to any 
country where such transfer is prohibited by the United States Export Administration Act, or any successor 
legislation, or in violation of the laws of any other country. 
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Getting started 
This section will walk you through how to get started using your V640 ExpressCard. This includes software and driver 
installation, inserting the card so Microsoft Windows is able to detect and install the drivers for your V640 
ExpressCard and setting up a data session to connect to the Internet. 

 

 

Important: Prior to using BroadbandAccess/NationalAccess service you must: 

1. Install VZAccess Manager version as provided with your installation CD 

2. Activate service using BroadbandAccess/NationalAccess V640 ExpressCard 

Customer Service 
For Customer Service while in the U.S. or Canada, dial 1-800-922-0204.  

V640 ExpressCard System Requirements 
Operating System: Windows 2000, XP 

Card Slot: ExpressCard34/54/Card Bay*   

Pentium processor: 166 MHz 

Disk Drive: CD ROM 

Memory: 32MB 

Disk Space: 14 MB 

Internet Browser 

* Card Bay requires card caddy accessory 
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Your V640 ExpressCard 
Your V640 ExpressCard fits into the ExpressCard slot (54 or 34 slot) of most Windows based laptop computers.  
The V640 ExpressCard utilizes Verizon Wireless’s network to connect to the Internet and is capable of 
transferring data at speeds up to 2.0Mbps*.  The Verizon V640 ExpressCard runs on Microsoft 2000 and XP. 
VZAccess Manager allows you to control and monitor your connection.  It will also allow you to send and receive 
SMS (Short Messaging Service), get online help and has an address book. 

*Speeds average 400-700 kbps with bursts capable of 2Mbps based on our network tests with 5MB FTP data files, 
without compression. Typical upload speeds of 60-80 kbps. Actual speeds and coverage may vary. 

 
ExpressCard: this is the device that when plugged into a Personal Computer provides wireless data solutions  
Computer Interface Connector: connects to your Personal Computer via the computer ExpressCard slot 
Service/Data LED: visual indicator that shows you service and data modes  

 

LED Color, Flashing Pattern Meaning 
OFF Radio is off and the card is in the Slotted state. 
Red LED – Steadily blinking The radio is not attached to the network or is in the disabled mode. 
Red LED – Slowly blinking The radio is off and the card is in the Slotted state or the radio is in USB 

Selective Suspend. 
Green LED – Steadily blinking  The radio is on and the card is in the Active state with an active data 

connection. 
Green LED – Slowly blinking The radio is in USB Selective Suspend and the card is in the Active state 

with an active data connection. 

 

Computer 
Interface 

LED Antenna 

ExpressCard 
(top side) 
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Care of Your V640 ExpressCard  
Verizon Wireless recommends the following handling guidelines:   

Handle with care 
Avoid storing your V640 ExpressCard in extreme temperatures 
Store the card in a dry and clean environment 
Avoid spilling any liquid or immersing the card in water 
Do not place any labels on the Antenna as this may alter the sensitivity of the antenna 
Do not place any labels on the card as this may interfere with the ExpressCard slot when inserting 
Do not force the V640 ExpressCard into the ExpressCard slot 
Do not apply force on the top or bottom of the V640 ExpressCard 

When transporting your laptop, remove the V640 ExpressCard from the ExpressCard slot 

The V640 ExpressCard Package 
The Verizon Wireless V640 ExpressCard Package includes: 

• V640 ExpressCard 
• VZAccess Manager CD ROM 
• Quick Reference Guide 

 

 

IMPORTANT:  Do not insert the V640 ExpressCard into the ExpressCard slot until you have installed VZAccess 
Manager and have activated a BroadbandAccess/NationalAccess service for your V640 ExpressCard.   
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Introduction 

VZAccessTM Manager from Verizon Wireless: 
Welcome to the Verizon Wireless VZAccess Manager.  VZAccess Manager provides easy access to the wireless 
Internet.  It has built-in support for both WWAN and Wi-Fi devices, giving you the flexibility to connect your notebook 
to the Internet wirelessly anytime, anywhere. 

Supported Services 
VZAccess Manager supports the Verizon Wireless BroadbandAccess/NationalAccess service. This service 
requires a dual-band CDMA 1xRTT and an EV-DO capable ExpressCard (such as the V640 ExpressCard). The 
Verizon Wireless BroadbandAccess/NationalAccess service provides a superior wireless data connection, 
supporting rates up to 2.0Mbps*.  
 

*Speeds average 400-700 kbps with bursts capable of 2Mbps based on our network tests with 5MB FTP data files, 
without compression. Typical upload speeds of 60-80 kbps. Actual speeds and coverage may vary. 
 

VZAccess Manager System Requirements 
In order to set up VZAccess Manager, you will need the following minimum system requirements: 

• Microsoft Windows: Windows 2000 Professional, or Windows XP (Home, Professional, Media Center or 
Tablet PC Editions) 

• Pentium 166 MHz or higher 
• Verizon Wireless V640 ExpressCard  
• Optional Wi-Fi adapter for Wi-Fi access 
• Internet browser software for Internet access or the software used by your company for network access 
• Verizon Wireless data service 
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Installation and Configuration 
This section will guide you through the installation and setup process for the VZAccess Manager.  Before getting 
started, you should become familiar with the documentation that came with your ExpressCard. 

Getting Started 
Follow these steps to install VZAccess Manager: 

1. Turn on your computer and close all applications. 

2. Insert the CD-ROM into your CD drive. 

3. If set up does not automatically start, click the Start button on the taskbar and choose Run. Type D:\Start 
(where D is the letter of your CD-ROM drive) and click OK. 

4. Follow the steps in the next section... 
  

 

Important:  The following installation must be performed within a BroadbandAccess/NationalAccess coverage.

Important:  Your new BroadbandAccess/NationalAccess version of VZAccess Manager must be installed even 
if you already have a previous version loaded.  

Important:  VZAccess Manager must be installed before you insert the V640 ExpressCard into the computer for 
the first time.  Only after the software has been installed can the operating system successfully install and 
configure the V640 ExpressCard. 

VZAccess Manager Setup Program 

Step 1  
Double-click VZAccess Manager setup program.  
You will be presented with a "Welcome" screen.  
Click the Next button to continue with the 
installation process. 
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Step 2 
After the Welcome screen you will see VZAccess 
Manager License Agreement.  In order to install and 
use this product you must agree with the terms of 
this agreement.  Select "I agree with this software 
license agreement," then click the Next button to 
continue.  If you do not agree with this agreement, 
click the Cancel button to exit. 

 

Step 3 
You are now ready to select the location on your 
computer where VZAccess Manager should be 
installed.  It is recommended that you do not modify 
the default destination folder.  Click the Next button 
to continue. 
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Step 4 
You are now ready to begin installing VZAccess 
Manager components onto your computer.  Click 
Next to continue. 

 

Step 5 
During this step the components of VZAccess 
Manager product are being installed onto your 
computer.  Installation will occur to the destination 
folder specified in Step 3 above. 
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Step 6 
Installation is now complete.  Click the Finish 
button to leave VZAccess Manager setup program 
and begin using your new software. 

The setup program will automatically create a VZAccess Manager shortcut on your desktop. 

VZAccess Manager Setup Wizard 
After you have successfully completed the installation process of VZAccess Manager, you are ready to start 
VZAccess Manager and begin your initial setup.  The steps in the Setup Wizard are critical to the proper operation of 
VZAccess Manager when using your WWAN or Wi-Fi device to connect to the Internet wirelessly.  Do not insert your 
V640 ExpressCard until instructed to do so. 

Step 1 
Click the Start button, select the Programs menu and choose VZAccess Manager menu item to start VZAccess 
Manager program. 
 

Step 2 
On first-run of VZAccess Manager the Setup Wizard 
will automatically run.  You will be presented with a 
Welcome screen.   

If you have an Internet connection, it is 
recommended that you check to see if you are 
running the latest version of VZAccess Manager.  
Click the Check for Updates button to perform this 
check. 

Click Next to continue. 
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Step 3 
In this step of the Setup Wizard you must specify 
the type of wireless device that you intend to use 
with VZAccess Manager.  Select either "Detect 
both Wi-Fi and WWAN" or "Detect WWAN device 
only." For the purposes of this guide, "Detect both 
Wi-Fi and WWAN" will be used. Please note that 
your experience in Step 4 may be different if you 
use a different selection.  After making the 
appropriate selection, click Next to continue.  

 

 

Step 4 
In this step VZAccess Manager will detect the Wi-Fi 
adapters on your computer.  If your computer has a 
built-in Wi-Fi adapter, you do not need to do 
anything and can proceed to the next step.  
Otherwise, please insert your Wi-Fi ExpressCard 
now.  You will need the drivers for the card if not 
already installed on the computer.  Once complete, 
click Next to continue. 

 

 

 

Note:  WWAN (Wireless Wide Area Network) denotes any 1xEVDO, 1xRTT or CDMA connection to the Verizon 
Wireless network such as BroadbandAccess or NationalAccess.  
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Step 5 
VZAccess Manager will now detect and setup your 
WWAN device. 

 

 

Step 6 
In this step you need to select the type of 
connectivity you wish to use with your wireless 
device.  For the purposes of this guide, we will 
select the radio button associated with "PC Card or 
ExpressCard."  Once you have selected your 
connectivity option, click Next to continue. 

Please note that Bluetooth only applies to handsets 
that support Bluetooth. 
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Step 7 

Insert your V640 ExpressCard now, and wait for 
Windows to detect and install drivers for the device. 

IMPORTANT: When inserting or removing theV640 
ExpressCard, grip both sides, do not handle the 
V640 ExpressCard by pulling on the antenna 

 

 

 
 

If the card is detected, you will see the following 
screen. 

If your device is not activated, you will need to click 
"Activate" for the Over-The-Air (OTA) activation 
process to take place. You will see a dialog displaying 
the status of the OTA activation process. 

 Note: If your device is already activated, you 
will not see the "Activate" button on this 
screen. 
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Step 8 
The detection and configuration process for your 
ExpressCard is now complete.  In this step you can 
elect to run VZAccess Manager automatically every 
time you start up your computer.  To do so, check 
the "Run VZAccess Manager at Startup" checkbox.  
Click Finish when complete. 

 

 

Please familiarize yourself with the information in the "Using VZAccess Manager" and "Connecting to the Internet" 
sections of this guide.   
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Using VZAccess Manager 
Today's online world offers more services everyday and Verizon Wireless gives you the tools you need to take 
advantage of the best in connectivity solutions. With VZAccess Manager, enjoy the freedom and convenience of 
wireless Internet connectivity from your notebook computer! 

Features 

WWAN (Wireless Wide Area Network, CDMA 1xEV-DO and 1xRTT) Specific Features 

• Configures your PC to use your wireless device as a modem. 

• Creates BroadbandAccess connection if using a BroadbandAccess-capable device.  This connection will 
automatically fall back to NationalAccess if BroadbandAccess is unavailable. 

• Copy utility to create wireless copies of your dial-up connections. 

• Signal strength and battery level display. 

• Features a test function for your WWAN device.   

Wi-Fi Features 
• Configures Wi-Fi Adapter to work with VZAccess Manager. 

• Displays Wi-Fi connections and signal strength when in a Wi-Fi coverage area.  Supports connecting to Wi-
Fi networks such as ones used at home or work. 

• Supports built-in Wi-Fi adapters or ExpressCards. 
 

 

A WWAN-capable ExpressCard is required to use the WWAN features.  Individual WWAN features are also 
device-dependent as described in the WWAN section above. 

 

Other Features 
• Can launch your browser, e-mail client, VPN or a program of your choice upon connection. 
• Logs connections used, duration and bytes sent and received. 
• Supports TXT messaging. 

Getting Started 

  

Double click on VZAccess Manager icon on your desktop or click on the Windows Start menu and select 
Programs > VZAccess Manager from the list of programs. 
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VZAccess Manager Setup Wizard 

The first time you launch VZAccess Manager, you will see VZAccess Manager Setup Wizard: 

 
Stepping through this wizard is critical to properly setting up your WWAN or Wi-Fi device. Please follow the on-
screen instructions. 

About the Networks View 

When the Setup Wizard is complete, VZAccess Manager displays the "Networks" view. This view lists all currently 
available network connections and indicates their respective signal strengths: 

At a glance you can see the signal strength and battery level (if applicable) of your WWAN or Wi-Fi network.  Select 
"Refresh Networks" or "Refresh Signal Levels" from the "Options" menu to update the information in this panel.  Your 
current connection state and the elapsed time of the connection are displayed along the bottom of the status bar. 

 

 

The status bar along the bottom of the window displays your current connection state and the elapsed time of any 
connection. Additional information is available in "The Status Bar" topic. 
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Connecting for the First Time 
Once your Wi-Fi or WWAN device is properly configured, connecting to the Internet is as simple as selecting the 
network connection type shown in the list and clicking the Networks button.  Note that the Networks button 
immediately above the list will change to "Connect" or "Connect Wi-Fi" as appropriate based on the current selection 
in the networks list. 

 
 
1. To connect to Verizon Wireless for the first time: 

• Select “National Access–BroadbandAccess.” 
• Click the Connect button or simply double-click the network name. 
• If your device has not yet been activated, you will be directed to a Verizon Wireless website to set up an 

account.  

Disconnecting  
Once connected, the Connect button will change to Disconnect.  Simply click Disconnect to end your current 
connection or double-click the network name again.   
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Other Notes 
If your expected connection does not appear: Select "Refresh Networks" from the "Options" menu.  This 
will cause VZAccess Manager to look for your wireless device(s) and verify network availability.   

Changing Wireless Devices: If you change wireless devices, you will need to run the Setup Wizard again.  
To do this make sure that your phone and cable are connected, then select "Run Wizard" from the "Options" 
menu.   

 

Wi-Fi networks: 
• If you have any Wi-Fi networks you manually added because they do not broadcast their SSID, they 

will always be displayed, and you will have to refer to the signal strength displayed to know when you 
are in range.  See the section "Wi-Fi Specific Settings" for additional details. 

• Note that with certain Wi-Fi adapters the signal strength for Wi-Fi networks is not accurate until you 
connect to the network. 

 

NationalAccess and BroadbandAccess Connections: 
• The NationalAccess connection is only created when the WWAN option is selected during setup and 

if you are using a NationalAccess capable device that does not support the Verizon Wireless 
BroadbandAccess service.   

• If you are using a BroadbandAccess capable device, a BroadbandAccess connection will be created.  

• This connection will use BroadbandAccess if available and will automatically attempt a 
NationalAccess connection when BroadbandAccess is not available. 

 

 

For further troubleshooting tips, please refer to Troubleshooting. 
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Connecting  
Once your Wi-Fi or WWAN device is properly configured, connecting to the Internet is as simple as selecting the 
network connection type shown in the list and clicking the Connect button.  Note that the Networks button 
immediately above the list will change to Connect or Connect Wi-Fi based on the current selection in the networks 
list. 

1. Select one of the following connections: "NationalAccess - BroadbandAccess" or "NationalAccess."  

2. Click the Connect button shown below when it becomes enabled.   

 
 

Once connected, the Connect button will change to Disconnect.  Simply click this to end your current connection.  
To connect to any other network shown, select it, and then select Connect.  

 

The Status Bar 
Information regarding your current network connection can be seen in the status bar along the bottom of the 
VZAccess Manager interface.  For more information on this status bar, see the section "The Status Bar" in the 
"Additional Features" section.  
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Note: If you are using a WWAN device that supports the Verizon Wireless dial-up data service and you made 
wireless copies of your dial-up accounts, they will also appear.  See the section "Creating Wireless Copies of your 
Dial-Up Connections."  Optionally you can have all dial-up connections appear in VZAccess Manager and use it to 
launch any dial-up networking connection.  See the section "Setting Your Preferences."  If you are in the presence of 
a private Wi-Fi network (such as one at work or at home) it will also appear if you selected the Wi-Fi option during 
setup.  If the number of connections exceeds what can be displayed, a vertical scroll bar will appear to the right of the 
connections.  Scroll down to see them all. 
 

 

The first time you connect with BroadbandAccess/NationalAccess, BroadbandAccess, NationalAccess, 
or a private Wi-Fi connection, a connectivity warning message will appear. You have the option to suppress 
these warning messages when they are displayed. 

 

VZAccess Manager will display status information at the bottom during the connection process as well as while 
connected.  When not connected, the status text in the lower left corner will display "Not connected" for the currently 
selected network.  The timer will display "00:00:00."  Once connected, the status text will display "Connected" and 
the elapsed timer will begin to run.  When a connection is active, its name will appear as bold text. 
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The status is also reflected in the Task Tray icon. 

 

 

Connected 

 

 

Idle - Not Connected 

 

 

Connecting 

 

 

Disconnecting 

 

 

A window will also slide out of the tray showing when you connect and disconnect 
from networks. 

 

The pop up status can be turned off, if desired, by selecting "Options," "Preferences," "Options" tab, un-checking 
"Show pop-up status windows by tray." Right clicking on the tray icon provides various options and double clicking on 
it will always show the application. Placing your cursor on it will display the current connection status. 

Based on your preferences, your browser or e-mail or VPN program can be launched automatically, or you can 
launch whatever software you want to use. You can also determine if all connections show in the drop down list or 
only your wireless ones, see Setting Your Preferences. 

Note: Always use VZAccess Manager when connecting via BroadbandAccess or NationalAccess.  This will ensure 
the wireless device is configured properly before connecting. 

At any time during your connection you can check your current connection speed and throughput stats in the 
Statistics tab of the Session Information window.  To see this window, select "Statistics" from the "Options" menu. 
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The Session Information window will also contain a My Computer tab and a Wi-Fi tab if applicable.  The My 
Computer tab contains detailed information about your computer.  This information is helpful when troubleshooting a 
problem. 

   
Additional information when using the NationalAccess connection: 

If you are using the BroadbandAccess/NationalAccess or NationalAccess connection and the call fails when you 
try to connect, with VZAccess Manager returning to its idle state, you should try to connect again. If you feel you may 
have incorrectly entered your wireless account number during initial setup, select "Options," "Run Wizard." 
 
Dormancy: 

NationalAccess and BroadbandAccess data sessions become dormant if you are not sending or receiving any 
data. As soon as you resume sending or receiving data, the data session will return to an active state.  

Depending on your device and your NationalAccess or BroadbandAccess plan, your data session may disconnect 
during a dormant state.  See your Verizon Calling Plan brochure for details or visit www.verizonwireless.com  If this 
happens, select disconnect, and then connect again.  

http://www.verizonwireless.com
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Warning Messages 

NationalAccess 
The first time you connect via the NationalAccess connection, the following warning message will be displayed: 

ATTENTION 

You are about to establish a NationalAccess (1xRTT) data connection.  Charges apply in accordance with your 
subscription to your Verizon Wireless NationalAccess. 

To see our current pricing for NationalAccess, please visit http://www.verizonwireless.com/b2c/mobileoptions  
  

This message will display each time you go to connect via the NationalAccess connection until you select "Do not 
show this warning again." 

BroadbandAccess 
The first time you connect via BroadbandAccess, the following warning message will be displayed: 

 

ATTENTION 

You are about to establish a BroadbandAccess or NationalAccess data connection. Charges apply in accordance with 
your subscription to your Verizon Wireless NationalAccess/BroadbandAccess. 

To see our current pricing for BroadbandAccess, please visit http://www.verizonwireless.com/b2c/mobileoptions  
  

This message will display each time you go to connect via BroadbandAccess, until you select "Do not show this 
warning again." 

Wi-Fi 
The first time you connect to a Wi-Fi network, you will see the following warning:  

 

ATTENTION 

You are about to establish a connection to a Wi-Fi network.  Verizon Wireless does not support problems associated 
with Wi-Fi networks.  

Verizon Wireless Customer Care will not be able to assist you. Please see the Help file for details. 

In most cases connecting to a private Wi-Fi network is a simple process and you can use VZAccess Manager instead 
of the Wi-Fi client you would normally use. If you have any problems doing this try the recommendations in the 
section on Wi-Fi Troubleshooting.  

http://www.verizonwireless.com/b2c/mobileoptions
http://www.verizonwireless.com/b2c/mobileoptions
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Using Dial Up Connections 
This section is only applicable if you are using a WWAN Device that supports dial-up connections. 

You can make wireless copies of existing dial-up accounts on your system.  This will wirelessly enable them and 
allow you to connect to them wirelessly. 

To launch the copy utility, select "Tools," "Dial-up Accounts" then "Copy." 

Click on the connection or connections you want to copy and click on the "OK" button. 

 
 

The new connection will have a suffix of "(Wireless)" and will be set to use your wireless device as the modem.  If the 
utility is unable to automatically recognize your existing area code and number, the existing number will be displayed, 
and you will be prompted to enter the area code and number.  The utility configures the new wireless connections to 
always dial 11 digits, so that they will work locally and also in other digital data coverage areas. 

 If it is determined that the connection might benefit by further optimization, an additional connection with a "(Wireless 
Optimized)" suffix, will also be created.  This connection may connect faster.  If you have trouble with the "(Wireless 
Optimized)" connection, you can delete it from your dial-up networking folder and use the "(Wireless)" connection. 

 Note: Some applications, such as AOL and JUNO, have dial-up networking connections that can't be used directly 
from VZAccess Manager or Dial-Up Networking.  Copies of these connections will not work with your wireless device, 
since the original connections do not work by themselves.  In most cases the original connections or the software can 
be configured to use your wireless device as a modem.  For the easiest way to configure AOL to work with your 
wireless device, see the section on Configuring AOL. 

To delete connections: 

Windows 2000 and XP users can access Dial-Up Networking from VZAccess Manager by selecting "Tools," "Control 
Panels," "Network and Dial-up Connections," right click on the desired connection and select "Delete." 
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TXT Messaging 
VZAccess Manager supports TXT Messaging for ExpressCards. 

  

Receiving TXT Messages 
• All of your TXT messages will appear at the list box at the top of the TXT messaging view.  By default, all 

sent and received messages will appear. 
• To view only certain messages, click on the 'View' toolbar button and select 'Received Messages', 'Sent 

Messages' or 'All Messages'. 
• If you are in the TXT Messaging view and a new message arrives, the message will automatically appear 

in the list and be displayed in bold. 
• To view a long TXT message, select the message in the list view.  The details of the message will 

appear below the list. 
• If you are not in the TXT Messaging view and a new message arrives, a TXT icon will appear in the 

status bar showing that new messages are available.  There is also a TXT preference option that can 
automatically switch VZAccess to the TXT view when new messages arrive.  By default, this feature is 
turned off. 
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• To reply to an inbound message, select the message and press the 'Reply' toolbar button.  The 
ExpressCard number of the sender will be populated in the send area below.  Enter your new message 
and press the 'Send' button to send the message. 

• To forward an inbound message, select the message and press 'Forward' toolbar button.  The message 
will be populated in the send area below prefixed with a "FW:."  Press the 'Send' button to send the 
message. 

• To resend a sent message, select the message and press the 'Resend' toolbar button.  The 
ExpressCard number and message will be populated in the send area below.  Press the 'Send' button to 
send the message again. 

Sending TXT Messages 

• While using the V640 ExpressCard, to send a text message to: 
- a US-based wireless number, enter: +, 1, then the wireless number. 
- a wireless number outside the US, enter: +, 011, the country code, then the wireless number. 

• To send a TXT message to one or more Verizon Wireless subscribers, enter their 10-digit mobile numbers 
separated by semi-colons in the "To..." field. (Ex: 2125551234; 2125554567). If you use commas, the 
application will automatically replace them with semi-colons.  

• With some devices that support TXT messaging contact lists, you may be able to click on the To... button to 
open your contact list. 

• To Send a TXT to one of the entries in your Contact List, click the To… button to open the Contacts 
window.  Simply double click on the name of the user and that individual will automatically be added to the 
'Send To' field. Holding down the 'Ctrl' key while you click names from the lists will allow you to select 
multiple names at once. 

• The phone number and the message field are required. 
• The Character counter counts up from 0 to 160 and counts all of the characters typed in the message field. 
• Click the Send button. 

TXT Contacts 
The Address Book allows you to store the names and mobile numbers of your personal contacts.  

To create a personal contact:  
• From the Contact List dialog, press the Add button. 
• Enter the full name of the contact into name into the 'Name' field. 
• Enter either the 10-digit mobile number into the 'Mobile 1' field. 
• The 'Mobile 2' field can be used to enter a second mobile phone number.  This is used if the individual 

sends you a message from this number.  You will see the user's name next to the inbound message 
instead of the phone number. 

• Click the OK button. The contact name will now display in the list. 

 

To edit a personal contact:  
• Click a name from the list and press the Edit button.  
• Make the necessary changes and click the OK button.  
• Clicking the Cancel button will not save any changes you have made.  
• Clicking the Delete button will remove that name from your list.  



 
V640 ExpressCard USER GUIDE   27

VZAccess Manager Preferences 

WWAN Settings 
To access the WWAN preferences, click on the "Tools" menu, then "Preferences...." 
  

 

Connect Options 

The "Set Options..." Button: This is used to set various connect options.  See below. 

Automatically Connect: If desired, you can select to have VZAccess Manager automatically connect at application 
startup. 

"Do not allow connectivity when roaming:" Enabling this option will prevent you from connecting when roaming. 
This option is disabled if using NDIS mode. VZAccess Manager only supports this feature with certain devices; if not 
supported, the option will not appear. 

NDIS Mode: Enables/disables the NDIS feature.  Please note that NDIS is only supported by some ExpressCards.  It 
also requires either Verizon Wireless BroadbandAccess or NationalAccess coverage, and either Windows 2000 or 
XP.  When enabled, NDIS provides an "always on" Internet connection similar to a standard Network Interface Card 
(NIC).  Please note that an NDIS broadband connection will remain active even if you exit VZAccess Manager. 



 
V640 ExpressCard USER GUIDE   28

Account Options 
  

Show non-wireless accounts in list: If you select this option, all of your dial-up accounts will show up in VZAccess 
Manager's list of accounts, allowing you to use VZAccess Manager to launch them instead of Dial-Up Networking.  
With this option unchecked, the only connections that are displayed in VZAccess Manager's list of accounts are 
Verizon Wireless connections and any other connections you have created.  If VZAccess Manager is also configured 
for Wi-Fi, these connections will also be displayed when in coverage of the hot spot. 

 Do not prompt for user name and password: If you are only using BroadbandAccess or NationalAccess, this 
setting has no effect.  If you created Wireless connections to dial into other networks or have existing connections 
you are going to launch using VZAccess Manager, checking this option will skip the screen that normally asks for 
your user name and password.  For this to work you will have had to connect previously, successfully saving your 
user name and password. 

Security Options 
The "Security Setup..." Button: This is used to lock/unlock the V640 ExpressCard as well as change the lock code 
on the V640 ExpressCard.   

Device Options 

Show wireless device battery instead of PC battery: (This option will only appear if you are using VZAccess 
Manager with a handset.) If you are using a WWAN device and this option is selected, the battery level of your 
WWAN device will be displayed when your device is connected and detected by VZAccess Manager, as well as 
when you connect and disconnect using your WWAN device. Battery Status cannot be updated while you are 
connected to a Wireless Wide Area Network (WWAN). You can refresh the status when you are not connected, by 
selecting "Tools," "Refresh Signal Levels" from VZAccess Manager's main window. ExpressCards do not use 
batteries, so you can use this option to display the PC/notebook's battery instead.   
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The "Set Options" Button & Its Dialog 
The Connect Tab 
When you select the "Set Options" button from the screen above, the following options appear: ("Tools," 
"Preferences," "WWAN tab," "Set Options. . . "): 
 

 
   

Do not open my browser: With this option selected, when you connect to a WWAN network, VZAccess 
Manager will not automatically launch your default web browser. 
Open my browser to my default home page: With this option selected, when you connect to a WWAN 
network (BroadbandAccess or NationalAccess), VZAccess Manager will automatically launch your default web 
browser and your  home page will load. 
Open my browser to this URL: With this option selected, when you connect to a WWAN network 
(BroadbandAccess or NationalAccess), VZAccess Manager will automatically launch your default web browser 
but do it in such a way that the URL you specify will load instead of your home page. 
Turn off graphics: If you select this it will turn off graphics in Internet Explorer. 

Note: With these options off, web pages will load faster but you will have to right click and select "show 
picture" for any pictures you want to see.   

 
Run program on connection:  This allows automatically running a program when you use VZAccess Manager 

to connect to a WWAN network. Select  the browse button, , to browse to the desired application you want to 
run when you connect to a WWAN network using VZAccess Manager. The application will run for all WWAN 
connections made from VZAccess Manager.  
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The VPN Tab 
The following options exist on the VPN tab ("Tools," "Preferences," "WWAN" tab, "Set Options. . . ," "VPN" tab): 

  

 
  

VPN Client:  VZAccess Manager automatically detects if certain VPN clients like Microsoft, Cisco, CheckPoint, 
etc are installed on the computer and allows you to select the one you wish to use.  Check with your network 
administrator to setup your VPN connection. 
If the VPN client you wish to use does not appear in the list, you can select Other VPN Application. 
Other VPN Application: This allows running a VPN program when VZAccess Manager connects to a network. 

Enter the full path to an executable, or select the browse button, , to find the path to the desired application. 

Security Setup 
When you select the "Security Setup" button from the screen above, the following options will appear ("Tools," 
"Preferences," "WWAN tab," "Security Setup. . . "): 
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Lock code: Enter your 4 digit lock code (The default lock is the last four digits of your device's phone number) and 
select OK to lock or unlock the wireless device. Warning: If you plan to use this device feature, we recommend you 
change your lock code to a new number.  

Change Lock Code: This is used to change the 4 digit lock code on the V640 ExpressCard  

 
Current lock code: Enter your current 4 digit lock code. 

 New lock code: Enter your new 4 digit lock code. 

 Confirm new lock code:  Re-type the new 4 digit lock code. 

Wi-Fi Settings 
To access the Wi-Fi preferences, click on the "Tools" menu, then "Preferences...." and select the "Wi-Fi" tab. 

The following options are available if you selected "detect Wi-Fi" device during setup. If you have added a Wi-Fi 
device after having installed VZAccess Manager, you can select "Options," "Run Wizard" to run the setup wizard 
again. 

If you connect your Wi-Fi device after VZAccess Manager has been started and you are in coverage of a Wi-Fi 
network, selecting "Options," "Refresh Networks" will allow VZAccess Manager to recognize your Wi-Fi device (and 
WWAN if connected) and scan for available networks. 
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Wireless adapters: In the rare case you have more than one Wi-Fi adapter, you can select the Wi-Fi adapter you 
are using. If your adapter does not appear, try upgrading to the latest available drivers from the Wi-Fi device 
manufacturer.  
  

Automatically connect to preferred networks: If desired, you can select to have VZAccess Manager automatically 
connect to your preferred Wi-Fi networks when they are detected.  
  

Automatically switch from WWAN to Wi-Fi: Requires that "Automatically connect to preferred networks" is 
selected. When you select this option to automatically switch from WWAN to Wi-Fi, VZAccess Manager will 
disconnect your WWAN connection (BroadbandAccess or NationalAccess) and automatically connect via Wi-Fi when 
a preferred Wi-Fi network is detected.  
  

Preferred Networks: When you connect to or add Wi-Fi networks they will appear in this list. If using the 
"Automatically connect" feature VZAccess Manager will try to connect to the networks in the order they appear in this 
list. 
  

Move Up: Changes the priority of the Wi-Fi networks you have added or connected to in the past. This option is only 
available when you have two or more Wi-Fi networks in the “Preferred” list. 
  

Move Down: Changes the priority of non Verizon Wireless Wi-Fi networks you have added or connected to in the 
past. This option is only available when you have two or more Wi-Fi networks in the “Preferred” list. 
  

Add: Used to manually add Wi-Fi network. If you select "Add" you will have to enter the network's name and indicate 
if it is password protected. The only time you would need to use the "Add" feature would be if the Access Point 
providing the Wi-Fi coverage does not broadcast its network name (SSID). The easiest way to add a network that 
broadcasts its network name is to select the Wi-Fi network connection when it appears, and then select "Connect."  If 
it is password protected you will be prompted to enter your WEP (Wired Equivalent Privacy) key.  

Note: If you manually add a Wi-Fi network, when VZAccess Manager finds it, its signal strength will be 
displayed to the right of the network name when you are within coverage of that network. If you incorrectly 
entered the name, the signal strength will never indicate any signal.  

 

 

Note:  that with certain Wi-Fi adapters the signal strength for Wi-Fi networks is not accurate until you connect to 
the network. 

  

Edit: If you select a connection in the Preferred Network list, the Edit button will become active. Pressing it will 
provide you with three additional tabs that will be discussed below. 
  

Remove: This will remove any other Wi-Fi networks you have added or connected to in the past. Just select the 
network, then select "Remove." 
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Network Tab 
From the Wi-Fi tab (above, "Tools," "Preferences," "Wi-Fi" tab) if you select a network listed under "Preferred 
Networks" then select the "Edit" button or if you select the "Add" button, one of the following options will be displayed: 
  

 
  

The following options exist on the Network tab: 
  

Network Name: On the Network tab, for private networks you can edit or enter the Network name and specify if it is 
a closed network. Note: The name has to match the network to work. If the network broadcasts its SSID, instead of 
manually adding it, select the Wi-Fi network connection when it appears, and then select "Connect."  If it is password 
protected you will be prompted to enter your WEP (Wired Equivalent Privacy) key. 
 

 

Note: The name has to match the network to work.  Note that this name is case sensitive when entering it. 

  

Set Password: This option allows you to modify, delete or enter your Wi-Fi WEP keys for a private Wi-Fi network. 
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Connect Tab 
The following options exist on the Connect tab ("Tools," "Preferences," "Wi-Fi" tab, select "Add" or a network in the 
"Preferred Network" list and "Edit," then "Connect"): 
  

 
  

Do not open my browser: With this option selected, when you connect to a Wi-Fi network, VZAccess Manager will 
not automatically launch your web browser. 
  

Open my browser to my default home page: With this option selected, when you connect to a Wi-Fi network 
VZAccess Manager will automatically launch your web browser and your default home page will load. 
  

Open my browser to this URL: With this option selected, when you connect to a Wi-Fi network, VZAccess Manager 
will automatically launch your web browser but do it in such a way that the URL you specify will load instead of your 
home page. 
  

Disable IE Proxy settings for this connection: This option provides an automatic method to turn off proxy settings 
when connecting to a Wi-Fi network. This would typically be used if you normally use proxy settings at work to 
access the Internet and you wanted to access the Internet directly via Wi-Fi without using VPN (Virtual Private 
Networking) software.   
  

Run program on connection:  This allows automatically running a program when you use VZAccess Manager to 
connect to a Wi-Fi network. Select the browse button to browse to the desired application you want to run when you 
connect to a Wi-Fi network using VZAccess Manager. The application will run for all Wi-Fi connections made from 
VZAccess Manager.  
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VPN Tab 
The following options exist on the VPN tab ("Tools," "Preferences," "Wi-Fi" tab, select "Add" or a network in the 
"Preferred Network" list and "Edit," then "VPN"): 
  

 
  

VPN Client: VZAccess Manager automatically detects if certain VPN clients like Microsoft, Cisco, CheckPoint, etc 
are installed on the computer and allows you to select the one you wish to use.  Check with your network 
administrator to setup your VPN connection. 

If the VPN client you wish to use does not appear in the list, you can select Other VPN Application  
  

Other VPN Application: This allows automatically running any VPN program when you use VZAccess Manager to 
connect to the Wi-Fi network you added or edited. Select the browse button to browse to the desired VPN application 
you want to run when you connect to the Wi-Fi network you added or edited, using VZAccess Manager. If you have a 
shortcut you normally use to launch your VPN application you may want to right click on it and select properties to 
see where the program is located and how it's named. 
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Options 
To access the Options tab, click on the "Tools" menu, then "Preferences...." and select the "Options" tab. 

 

  
 

Network Display Options 
Only show preferred wireless networks at start up: This only applies to Wi-Fi networks. If checked, at startup, 
only networks in your Preferred list on the Wi-Fi tab are displayed (networks you have connected to in the past) 
otherwise, all detected networks are displayed. 
  

Display advanced Wi-Fi network information: This only applies to Wi-Fi networks. If checked, additional 
information will be displayed for Wi-Fi networks such as the channel, MAC address (also referred to as Physical 
Address) and type of security. 

Run Options 

Minimize Application into tray: With this option selected, when you minimize VZAccess Manager, instead of taking 
up space in your taskbar, it will just disappear.  You can get it back by double clicking on the tray icon,      
alternatively you can right click in the icon and select "Show Application."  

You can minimize the main window of VZAccess Manager by selecting the minimize icon (  ) in the upper right 
corner of the main window. 

Show pop-up status windows by tray: Enables status notification in a pop up window above the task bar that 
displays for a few seconds whenever connection status changes. 
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Run VZAccess Manager at Startup: Selecting this option adds VZAccess Manager to the Windows Startup group, 
unchecking it removes VZAccess Manager from the startup group. 

Automatically close conflicting applications: With this option selected, VZAccess Manager will automatically 
close any application it recognizes that is known to prevent it from working correctly.  For example, it may close the 
client software that was supplied with your Wi-Fi card, if it's known to conflict with VZAccess Manager controlling your 
Wi-Fi card. 

TXT Messaging Settings 
To access the TXT preferences, click on the "Tools" menu, then "Preferences...." and select the "TXT" tab. 

The following options are available for ExpressCards only that support TXT Messaging.   

  

Incoming message options 
Open TXT window on arrival of new message:  
 VZAccess Manager will automatically switch to the TXT view when a new message arrives. 
Play sound on arrival of new messages:  
  A sound file (.WAV) can be selected to play when new messages arrive. 

Outgoing message options 
Message delivery duration:   
 The duration of time that the Verizon Wireless network will attempt to deliver the message.  The default is a 

duration of 1 week. 
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Confirmations 
The following confirmation dialogs can be turned on or off: 

Warn before deletion of messages 
Confirm deletion of messages 
Confirm sent messages 

Updates Settings 
To access the Updates preferences, click on the "Tools" menu, then "Preferences..." and select the "Updates" tab. 
  

 
  

This feature allows VZAccess Manager to automatically check for software updates. If an update is available, you will 
be notified of it's size and approximate download times.  
  

You will be given the choice to download or cancel. If you select download, you will be presented with a display that 
shows the progress as the update is downloading with the option to cancel if desired. You do not need to download 
the updates wirelessly; you can use any connection to the Internet.  

 Note: If you download the updates wirelessly, normal usage charges apply. 
  

You can allow the software to check automatically for updates, daily, weekly (default), or monthly. It only checks 
when the application is running and when it detects that you are connected and able to access to the Internet. If 
desired, you can select "Manually" and the software will only check for updates when you select "Update Now" 
(pictured above), or when you select, from VZAccess Manager's main screen, "Help," "Check for Updates." 
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Additional Features 
In addition to the basic features mentioned in previous sections, VZAccess Manager has the additional features listed 
below. 

The Status Bar 
The details of your current connection can be seen in the status bar at the bottom of VZAccess Manager. This status 
bar is always visible when the interface is fully expanded.  For information on minimizing the VZAccess Manager 
interface, see the section "Minimizing the Interface." 

Most users will see the following "NationalAccess - BroadbandAccess" version of the status bar: 

 

 

 

Connection Status 
The text on the bottom left portion of the status bar below the "Verizon Wireless" text reflects your current state.  
During an active connection, this text will change to "Connected."  If you are not connected, it will display "Not 
Connected." 

WWAN Device Status Area 
The text that reads "Verizon Wireless" can change to the following: 
• Device not inserted - Your WWAN V640 ExpressCard is removed from the notebook. 
• Device not activated - Your V640 ExpressCard needs to be activated.  Select Activate from the Options menu. 

Coverage 

For ExpressCards, an icon will be displayed if you are in NationalAccess or BroadbandAccess coverage.  Move the 
mouse pointer over these icons to see the tool tip showing the name of the current service. 

NDIS 

The following icons also appear on the status bar to indicate your device's NDIS status: 

 
 

 NDIS is enabled and connected 

 
 

 NDIS is enabled but disconnected 
 

(No NDIS image) 
 

 NDIS is disabled. 
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New TXT 
If your device supports TXT messaging, an icon appears on the status bar to show that you have a new TXT 
message waiting.  Double click on the icon to jump to the TXT view to see the message. 

Throughput 
The amount of data that you have sent and received since the current network connection was initiated can be seen 
by holding the mouse over the green up and down arrows on the right side of the status bar. 

Battery Level 
The current battery level of your laptop can be seen on the right side of the status bar.   

Elapsed Time 
The amount of time that has elapsed since the current network connection was initiated is tracked on the lower right 
side of the status bar. 

Roaming Status 
VZAccess Manager displays Roaming status for the V640 ExpressCard.  These icons will show on the status bar in 
these scenarios: 

Icon Status 

 Roaming 

 Extended Network 

No icon displayed Home Network 

The Toolbar Buttons 

 

The "Networks" button 
Displays all of your available wireless connections and networks.  Please refer to the Connecting section earlier. 

The "Usage" button 
Provides a concise session log of your network activity.  Click on a column heading to sort the log.  This window also 
displays the total number of sessions as well as the total time connected.   

The information displayed in the Usage log can be customized using the controls that appear just below the list. 
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To view only the connection history of a specific network type, check the "Selected connection" checkbox and select 
the desired type from the drop-down list.  To view only the connections made during a specific interval, check the 
"Date range" checkbox and specify the date in the "From:" and "To:" fields. 

To export this log as a CSV file, click the Export button that is immediately above the log.  To clear the log, press the 
Clear button.  Note that clearing the log cannot be undone. 

The "Apps" button 
Add applications here that you want easy access to while connected to the wireless Internet.  VZAccess Manager will 
pre-load into this view links to Verizon Wireless web sites, and any Microsoft Office applications you have loaded on 
your computer. 

The "TXT" button 
The TXT button allows you to send short text messages to any other wireless device that supports SMS.   Note that 
this button is only available when using a wireless device that supports TXT Messaging. 

The "Web" button 
Launches the default web browser on your computer. 

The "Email" button 
Launches the default email application on your computer. 

The "Support" button 
Displays a variety of help options available to you.  Click this button to find assistance with a problem, to explore the 
full range of VZW products and services, or to contact Verizon Wireless. 

Minimizing the Interface 
The interface for VZAccess Manager can be minimized to take up as little screen real estate as possible.  To 
minimize the interface, select "Minimum" from the "View" menu. 

 
 

To exit the Minimum view, you have the following options: 

• In the top, right-hand corner, click the "Maximize" button (to the left of the Exit button) 

• In the View menu, de-select “Minimum”   

• Select any other option on the View menu.   
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The Tools Menu 

Preferences...:  
Provides access to the Preferences dialog box. For details, please refer to VZAccess Manager Preferences section. 

 

Control Panels 
From this menu you have access to your system's "Modem," "Network and Dial-Up Connections," and "Internet" 
control panels.  You can also see all control panels by selecting "All." 

Dial-Up Accounts:  Add, edit, or copy wireless dial-up accounts. 

• Add Wireless: This is used to create a wireless dial-up connection from scratch. 

• Add Other: This is used to create a regular dial-up connection from scratch. 

• Edit: This is used to edit properties of any dial-up connection. 

• Copy: See section on "Using Dial-Up Connections." 

 
 Dial-up account options are only applicable if using a WWAN device that supports dial-up accounts. 

 

The Options Menu 
Refresh Networks: This causes VZAccess Manager to verify devices connected and to scan for available Networks. 
Use this feature if you connected your equipment after launching VZAccess Manager. Pressing the F6 function key 
can also access this option. 

Refresh Signal Levels: This causes VZAccess Manager to query signal levels and update its display. This will also 
update the battery display for your WWAN device if it is not in an active data session. Signal levels are automatically 
refreshed when you launch VZAccess Manager, connect or disconnect. Pressing the F5 function key can also 
access this option. 

Statistics: If you selected to detect and install Wi-Fi during installation, there will be a Wi-Fi statistics tab with 
additional information and tools that are helpful in the event any troubleshooting of the connection is required. You 
can view key statistics including bandwidth and your IP address information, release your IP address, renew your IP 
address. If you selected to detect and install a WWAN device during installation, there will be a Statistics tab that will 
show data speeds during a session when using the WWAN device. NationalAccess delivers typical speeds of 60 to 
80 kbps, bursting up to 144 kbps. BroadbandAccess provides broadband-like speeds (up to 2.0 Mbps). There is also 
a "My Computer" tab; this tab has key information about your computer that may be helpful in troubleshooting any 
problems that may occur. It also has the option of being e-mailed to Verizon Wireless Technical Support. 



 
V640 ExpressCard USER GUIDE   43

Test WWAN Device:  Retrieve and display detailed information about your WWAN device such as manufacturer, 
model, version, etc.  Also, see the current battery (not with ExpressCards) and signal strengths.  This information can 
be valuable when troubleshooting a problem. 

 

The Help Menu 
Contents: Launches this help file. You can also access this help file from your installation CD. 

 

Check for Updates: Can be used with any connection to the Internet to check for software updates for VZAccess 
Manager.  

 Note: If downloading an update wirelessly, normal usage charges apply - see Update Options in Setting Your 
Preferences. 

Device Support Page: Takes you to the Verizon Wireless device support page that contains information about 
wireless devices, useful tips and hardware manuals. 

E-mail Verizon Wireless Support: This option will attempt to launch your mail client with the default address to e-
mail Verizon Wireless Support. 

About VZAccess Manager: Displays the software version. 
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Settings in other Applications 
This section describes special settings that might be required to use them over the Verizon Wireless network. 

Sync Applications 
Palm Incorporated's HotSync® and Microsoft Corporation's ActiveSync® are used for Personal Digital Assistants 
(PDAs). These programs are used to synchronize files between a notebook or desktop PC and PDA. These 
programs may conflict with your WWAN device. If you have any problems using your WWAN device, try turning 
these programs off as explained below. 
  
  

To turn HotSync On & Off 
  

Right click on the HotSync® icon in your task tray and the menu below will appear. Click on "Local Serial" and "Local 
USB" to remove the check marks. This effectively disables HotSync® and if it is causing a conflict this will allow your 
WWAN device to work. You can repeat this process to put the check marks back to re-enable HotSync®. If you are 
using an early version of HotSync®, you may not be able to uncheck the "Local" options without first checking 
"Modem" or "Network." If this is the case, you can always select "Exit" to close HotSync® and launch it from the Start 
Menu the next time you need it. 

 

To turn Microsoft ActiveSync® On & Off 

Right click on the ActiveSync® icon in your task tray and select "Connection Settings." 

  

Select/deselect "Allow serial cable or infrared connection to this COM port:" and "Allow USB connection with this 
desktop computer." Make sure they are unchecked if you are having trouble connecting with your WWAN device 
and restore them to their original settings when syncing your PDA.  Click "OK" when finished. 

  

Proxy Settings 
Proxy settings affect the way your computer and browser connect to other computers on the internet and local 
networks.  It is highly recommended that you consult your network support staff before changing these settings 
described here. 

Most corporations go through a proxy server to access the Internet via the corporate network. If you wish to access 
the internet directly through BroadbandAccess or NationalAccess, proxy settings must be turned off. If you are 
connecting to your corporation's network using VPN (Virtual Private Networking) and your corporation uses proxies, 
then you would need the correct proxy settings to be able to access the Internet. For exact details on the proxy 
settings needed when accessing your corporate network, contact your corporate network technical support 
department if you need additional assistance. 

Performance, when accessing the Internet directly, is improved because you eliminate any overhead of the VPN 
client.  
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Proxy settings if using Internet Explorer (version 5 and newer) 
If you are using proxy settings, when connected to a corporate network via your Network adapter, they will be 
entered under LAN settings. These settings apply to devices that appear to Windows as Network adapters - this 
includes Wi-Fi adapters as well as your Network adapter. You can access the LAN Settings by doing the following:  

Step 1: In Internet Explorer, select "Tools," "Internet Options." 
  

 
 

Step 2: Then select the "Connections Tab" and "LAN Settings." 
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If your company uses proxy settings they will appear here. 
 

     
 

Step 3: If you are only using Wi-Fi connections without VPN and you want to access the Internet directly, you would 
uncheck the first three options to turn proxy settings off. If using VPN and if the settings are present you would leave 
them. To restore the settings you would navigate back to this screen and recheck any boxes you had unchecked. If 
using a WWAN device, BroadbandAccess and NationalAccess have no proxy settings associated with them from 
within VZAccess Manager by default. This means you can access the Internet directly using these connections but if 
you connect via VPN and your company requires proxy settings, you will not be able to access the Internet when 
connected via VPN. Performance is better if you drop your VPN connection when you want to access the Internet 
directly, but, if desired, you can record all the settings on the "Local Area network (LAN) Settings" screen and on the 
screen that appears when you select the "Advanced" button (Step 5), enter these settings in the properties for your 
WWAN connections (BroadbandAccess, NationalAccess).  

Note: If desired, you can have proxy settings automatically turned off when you connect using Wi-Fi connections - 
See Wi-Fi Specific Settings. 
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Step 4: If you need to enter proxy settings connections used by VZAccess Manager, you would use the 
"Connections" tab in the previous step, highlight the connection -- ex. BroadbandAccess -- and then select 
"Settings." (If you need to navigate to this tab, from Internet Explorer's main screen, select "Tools," "Options" as 
shown in Step 1 and then the "Connections" tab.)  
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Step 5: The settings will be displayed.  You can now enter the same proxy settings you recorded in Step 3, if you 
desire to use VPN and your proxy settings with these connections. If necessary also enter the information recorded 
from the screen that appears after selecting the "Advanced" button. To disable proxy settings for these connections 
you would have to uncheck the "Use proxy server . . ." box. Proxy settings must be disabled to access the Internet 
directly when using these connections without VPN.  

 

 

Proxy Settings if using Internet Explorer 4.x: 
  

In Internet Explorer 4.x, proxy settings are global and have to be turned off when accessing the Internet directly 
through BroadbandAccess or NationalAccess and back on if required by your company when using their network to 
access the Internet or when using VPN.  

  

  

Step 1: Right-click on the Internet Explorer icon and go to Properties (or if Internet Explorer is already open go to 
View then Internet Options...). 

 



 
V640 ExpressCard USER GUIDE   49

 

Step 2: Click on the "Connection" tab. Uncheck the box labeled "Access the Internet using a proxy server" then click 
"OK" or "Apply." You may now access the Internet through BroadbandAccess or NationalAccess.  
 
  

When you wish to access the Internet through your corporate network proxy server, you must repeat these steps, 
checking the box labeled "Access the Internet using a proxy server." If your proxy setting is incorrect for the 
connection you are using, you will get an error whenever you try to go to any site. 

Proxy Settings if using Netscape Navigator 4.0 and higher:  
In Netscape Navigator 4.0 and higher, proxy settings are global and have to be turned off when accessing the 
Internet directly through BroadbandAccess or NationalAccess and back on if required by your company when using 
their network to access the Internet or when using VPN.   

Step 1: From within your browser, go to "Edit" then "Preferences." 

Step 2: Click on the "+" beside "Advanced" then "Proxies." Next select "Direct connection to the Internet" and click 
"OK." You may now access the Internet through BroadbandAccess or NationalAccess.  

Reminder: When you wish to access the Internet through your corporate network proxy server, you must repeat 
these steps, selecting "Manual proxy configuration" then clicking "OK." If your proxy setting is incorrect for the 
connection you are using, you will get an error whenever you try to go to any site.  

Instructions for AOL Users 
AOL supports using other connections to the Internet, so it can be used with the Verizon Wireless BroadbandAccess 
or NationalAccess connections.   

Configuring AOL Version 9  
Step 1: Right click on the AOL icon in your task tray, and then click on "Auto Start Options..." 
  

 
Step 2: Select "Don't use any Auto Start options," and then click the "OK" button.  (We have found it to be more 
reliable to manually launch AOL, rather than to use the Auto Start options.) 
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Step 3: The first time you run AOL (version 9), after setting your V640 ExpressCard up as a modem, you may get the 
following screen; select OK to proceed. 
  

 
Step 4: AOL will attempt to detect how it might be able to connect. 
  

 
Step 5: Once AOL detects a way to connect, select Cancel 
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Step 6: From the sign on screen select Sign On Options 
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Step 6: Select Expert Setup 
  

 
Step 7: Select Add Location 
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Step 7: For the location name enter Verizon Wireless and then select Next. 
  

 
Step 8: If "Other Dial-up ISP or LAN" is available select it then select Next and go to Step 10.  If this option is not 
available, select "(Manually add a connection device)" and then select Next. 
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Step 9: Select "Other Dial-up ISP or LAN" then select Next. 
  

 
Step 10: Select Next. 
  

 



 
V640 ExpressCard USER GUIDE   55

Step 11: Select Next. 
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Step 12: Even though AOL reports the location has been created, you must click on "Sign On to AOL Now" to save 
the changes.  Since you are not actually connected to the Internet, AOL will not actually be able to sign on, but it will 
save your changes. 
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Step 13: Select Close when you get the following error message.  This completes configuring AOL to work with any 
connection to the Internet, including BroadbandAccess and NationalAccess. 
 

 

Using AOL Version 9 with your Mobile Office Connections 
  

  

To use AOL with the Verizon Wireless BroadbandAccess or NationalAccess, select the desired connection from 
VZAccess Manager's main window and select "Connect."  
  

Once connected, launch AOL.  From your sign on screen, select "Verizon Wireless" for the location and sign on.   

Note: You can set VZAccess Manager to automatically launch AOL when you get connected.  For further help 
details, see the "Run program on connection" section on the Wi-Fi Specific Settings page and the WWAN Specific 
Settings page.  Check the box to "Run program on connection:," then click the  button to browse and select 
aol.exe, it should be located in your "C" drive in an America On Line folder, under the "Program Files" folder. 
  

Note: If you normally use a landline modem rather than connecting wirelessly, just remember to change the location 
back to the one you normally use.  Then change it back to "Verizon Wireless" when you use BroadbandAccess or 
NationalAccess. 
  

Reminder: To disconnect from BroadbandAccess or NationalAccess, click on the "Disconnect" button in VZAccess 
Manager. (Signing off AOL will not end the call.) 
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Using E-mail with VZAccess 

POP3 E-mail 
You can use BroadbandAccess or NationalAccess to access your POP3 e-mail account if your e-mail provider allows 
access through other providers (many do). If your provider restricts access to their outgoing mail server you will get 
an error message similar to the one below if you are attempting to send mail.  

Most send mail servers are not accessible from various connections to the Internet. You usually have to be 
connected to the e-mail provider's network to access their mail server and most e-mail providers require 
authentication (a user name and password). The reason everyone has had to resort to this is that without these 
measures, anyone can use a send mail server to send massive amounts of unwanted junk e-mail. If you are having 
trouble sending e-mail - this also includes replying and forwarding, and you are getting an error message similar to 
that shown above, then your send mail server can not be accessed from the Verizon Wireless network.  

For customers in this situation, Verizon Wireless has made available a send mail server that you can use in place of 
the one you normally use. All that is required is that you have a TXT messaging capable Verizon Wireless device and 
TXT messaging service, visit www.vtext.com and establish a profile there by selecting "Join Up" and completing the 
form. You will be asked to enter your 10 digit mobile number.  A TXT message will be sent to your device and will be 
used to establish your password. Most Verizon Wireless ExpressCards can receive TXT messages.  If you have a 
ExpressCard that is not capable of receiving TXT messages and you have a Verizon Wireless phone that is, you can 
use it to establish a profile on www.vtext.com as described above. 

To use the Verizon Wireless Send Mail Server, you will edit your existing Mail account settings and change the 
outgoing mail server you are currently using. In place of your existing Send Mail Server, enter smtp.vzwmail.net, 
select "My server requires authentication" and using the 10 digit mobile number you used to establish your profile on  
www.vtext.com, enter the 10 digit mobile number@vzwmail.net (i.e. 6145551212@vzwmail.net) for the Send Mail 
Server user name. For the password, use the password you established for www.vtext.com. You will also be able to 
use this server when connected to the Internet from various providers eliminating the need to change this setting 
when you switch from being connected to the Internet through Verizon Wireless and by various other means. If you 
need to know where these settings normally are in your e-mail client, check with your e-mail provider. For your 
convenience the settings for Outlook Express® are as follows: 

Step 1: Select "Tools," "Accounts." 
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Step 2: Select your default account, then "Properties."  

 
 

Step 3: Select the "Servers" tab. In the "Outgoing mail (SMTP):" field enter "smtp.vzwmail.net" without quotes. In the 
"Outgoing Mail Server" section at the bottom, select "My server requires authentication," then select "Settings." 
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Step 4: Select "Log on using," then using the 10-digit mobile number you used to establish your profile at 
www.vtext.com, enter the 10-digit mobile number@vzwmail.net for the account name (i.e. 
6145551212@vzwmail.net). For the password, enter the password you established on www.vtext.com. Select 
"Remember password." Select "OK," "Apply," "OK," "Close" to get back to the Outlook Express® main screen. It may 
take up to two hours for your www.vtext.com credentials to be valid on the smtp.vzwmail.net server. Once they are 
valid, you should be able to send mail using the Verizon Wireless Send Mail Server (also referred to as a SMTP - 
Simple Mail Transport Protocol Server), when you are connected to the Internet, wirelessly or via other means. 
  

 

Additional important notes about the Verizon Wireless Send Mail Server:  
 

• There is no monthly charge for this service. 
 

• Message Limits are as follows: 2MB Message Size, 100 Recipients per message. 
 

• Customers that are identified as using this server to generate SPAM messages (what most would consider 
unsolicited junk e-mail) will be denied access to this server (e-mail messages will not be sent). 

 

• If you are using an e-mail client other than Outlook® or Outlook Express® and it fails to work with the 
Verizon Wireless Send Mail server, it may not support authentication correctly. Try using Outlook Express® 
if you have any problems. If it works and your e-mail client does not, check to see if any updates are 
available for your e-mail client. 

 

NOTE: Credentials established on www.vtext.com may take up two hours before they will work on the 
smtp.vzwmail.net server. If your credentials work on www.vtext.com but not on the smtp.vzwmail.net server, try again 
after two hours.  

Web Based E-mail 
  

If you currently do not have e-mail software, or if you do not have a text messaging capable Verizon Wireless device 
or ExpressCard, you can sign up for web based e-mail at any of the popular portal sites, such as 
http://www.yahoo.com, or http://www.msn.com. You may also search for other e-mail providers from any of these 
pages. 
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Technical Support 

Data Technical Support 
For additional information and technical support for VZAccess Manager and Verizon wireless devices, you can visit 
Verizon's Data Technical Support page at: http://www.verizonwireless.com/b2c/support/data.jsp. 
 
 

Troubleshooting 

V640 ExpressCard 
The following tips will help solve many common problems encountered while using the V640 ExpressCard: 

• Make sure you are using the appropriate card in the correct geographic region: a 
BroadbandAccess/NationalAccess card in the US.  

• Ensure that the wireless network’s coverage extends to your current location.  
• Confirm that you have an up-to-date version of VZAccess Manager.  

WWAN 

When installing VZAccess Manager, it was not able to find the WWAN device  
(For a 1xEV-DO/1XRTT/CDMA ExpressCard). 

• If using a WWAN (1xEV-DO/1XRTT/CDMA) ExpressCard, try removing it and reinserting it by following 
the proper insert and eject hardware guidelines for your operating system. 

• Identify any software that uses the serial port on your computer or other USB devices (such as Microsoft 
ActiveSync and Palm HotSync) and exit all of these programs. See Turning Sync Applications On and 
Off. 

• Make sure that the auto-answer feature of any fax software you are using is disabled. 
• Check with your computer manufacturer to verify your serial port or USB port is enabled and properly 

configured. 

I get connected, but I can't get to any web sites. 
• If you are using VPN (Virtual Private Networking) you may require proxy settings on BroadbandAccess 

and NationalAccess if you wish to access the Internet when connected to a corporate network through 
VPN. To see if this is the case disconnect from your VPN and see if you can access the Internet directly. 
For additional information see Turning Proxy Settings On and Off.  

• If you are using a PC provided by your employer it's possible they might be using Microsoft's Winsock 
Proxy or a similar program that enforces Proxy settings without having to enter any proxy settings in your 
web browser. If this is the case, you will only be able to access the Internet when using VPN. To access 
the Internet directly you will have to disable the Winsock Proxy. Usually these applications have an icon 
in Control Panel that allows turning them on and off. Check with your Network Administrator if you think 
this might be the case. 

I can receive e-mail but cannot send e-mail using my e-mail program. 
Some Internet Service Providers require that you be connected through them to access their mail server 
to send e-mail. See section on E-mail Options. 
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My computer locks up or crashes when attempting to connect: 
• Refer to your computer manual for help in managing your serial COM ports and USB ports, to resolve 

potential resource conflicts. 
• Exit any applications that may use serial ports or USB ports, that might be causing a conflict and try again. 
• While trying to use your WWAN ExpressCard, remove any unrelated ExpressCard (PCMCIA) modems from 

your computer. 
 

My connection fails immediately, or I get a "Call Failed" message  

• Remove and reinsert the V640 ExpressCard from the ExpressCard slot. Then try to establish your session 
again. 

My communication software shows that I am connected, but my wireless phone does not. 

• Depending on your device and your NationalAccess or BroadbandAccess plan, your data session may 
disconnect during a dormant state.  See your Calling Plan brochure for details.  Select disconnect, 
then connect again  

• Your call may have been disconnected due to a network anomaly.  Disconnect and try to establish your 
session again.   

I get "There is no dial tone" while trying to connect, using my V640 ExpressCard or it 
seems as if the V640 ExpressCard is not being recognized at all. 

• Remove and reinsert the V640 ExpressCard from the ExpressCard slot. Then try to establish your session 
again. 

. • Raise the antenna on your V640 ExpressCard. If you are not within the digital coverage area, wait until you 
are back in the Verizon Wireless digital coverage area to place your call.   

Every time I try to establish a BroadbandAccess or NationalAccess connection, it fails. 

• If you feel you may have incorrectly entered your wireless telephone number during initial setup, from the menu 
bar select "Options" and then "Run Wizard."  After the wizard finishes, try connecting again. 
 

Wi-Fi  

When installing VZAccess Manager, it was not able to find the Wi-Fi device. 
• Verify that the client that came with the Wi-Fi device can talk to it. If it can't, contact the Wi-Fi device 

manufacturer for assistance getting it to work with the client it comes with. Then try VZAccess Manager 
again. 

• Check with the Wi-Fi device manufacturer to see if newer drivers are available. If they are, download and 
install them. 

• If using a Wi-Fi ExpressCard, try removing it and reinserting it. 
• On Windows 2000 and XP, this can happen if you do not have administrative rights. Check with your IT 

department, if you have one, to see if they limited your user rights. If they have, you will need their 
assistance to run the setup wizard with administrative rights. You can access the setup wizard from 
VZAccess Manager's main screen by selecting "Tools," "Run Wizard." 
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When installing VZAccess Manager, a dialog appeared stating that a feature in the Cisco® 
Aironet® Client needed to be enabled. 

• A simple configuration change is required to the Cisco® Aironet® Client to allow VZAccess Manager to work 
properly. Select, "Start," "Programs," "Cisco Systems," "Aironet Client Utility (ACU)," "Select Profile," then 
select "Use Another Application to Configure My Wireless Settings," and "Apply." 

When installing VZAccess Manager, a dialog appeared stating "You will need to upgrade 
your Wi-Fi card drivers before running this program. . ." 
Check with the Wi-Fi device manufacturer to see if newer drivers are available. If they are download and install them. 

I get connected, but I can't get to any web sites. 
• If you are using VPN (Virtual Private Networking) you may require proxy settings to access the Internet when 

Wi-Fi connections. To see if this is the case disconnect from your VPN and see if you can access the 
Internet directly. Also if you are not using VPN and you have proxy settings set, they will prevent you from 
accessing web pages. For additional information see Turning Proxy Settings On and Off.  

• If you are using a notebook provided by your employer, it's possible they might be using Microsoft's Winsock 
Proxy or a similar program that enforces Proxy settings without having to enter any proxy settings in your 
web browser. If this is the case you would only be able to access the Internet when using VPN. To access 
the internet directly you would have to disable the Winsock Proxy. Usually these applications have an icon in 
Control Panel that allows turning them on and off. Check with your Network Administrator if you think this 
might be the case. 

I'm unable to connect using Wi-Fi.  
• A low signal can cause this. Try moving within the Wi-Fi hot spot to improve your signal and try connecting 

again. 
• This can happen when your computer fails to successfully obtain an IP address. Try performing a release 

and renew by selecting the following from VZAccess Manager's main screen: "Session," "Statistics," "Wi-Fi" 
tab. The "Address type" should show "Assigned by DHCP." If it shows "Automatic Private Address" you have 
not been assigned an IP address from the Wi-Fi network. Select "Release," then "Renew."  

Try selecting "Disconnect" and then connect again. 

I can receive e-mail but cannot send e-mail using my e-mail program. 
Some Internet Service Providers require that you be connected through them to access their mail server to 
send e-mail. See section on E-mail Options. 

I connected OK, everything was working, then everything stopped working. 
• A low signal can cause this. Try moving within the Wi-Fi hot spot to improve your signal and try connecting 

again. 
If necessary, try disconnecting and reconnecting. 

My connection was lost. 
A low signal can cause this. Try moving within the Wi-Fi hot spot to improve your signal and try connecting again. 

I can't get VZAccess Manager to work with my private Wi-Fi Network. 
• First verify that the client that came with the Wi-Fi device works with your private network. If it doesn't, 

contact your Wi-Fi device provider and or the device provider of your network equipment. 
• In the section on Wi-Fi specific settings there are options to manually add a Wi-Fi network if it does not 

broadcast its Network ID (SSID) which would prevent it from appearing in VZAccess Manager.  There is 
also an option to enter / edit your WEP (Wireless Equivalent Privacy) password if your network requires one. 
If it was incorrectly entered, it could prevent you from connecting.  
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• The issue may be related to using WEP security and your specific Wi-Fi adapter. You may want to 
temporarily test your network without WEP to determine if this is the case.  If it works without WEP and fails 
using WEP, please e-mail Verizon Wireless Tech support with your computer and Wi-Fi device info by doing 
the following: From VZAccess Manager's main screen select "Session," "Statistics," "My Computer" then "E-
mail  Technical Support." Please also include in the body of the e-mail your computer brand, model and any 
Wi-Fi device information you have - built in device or ExpressCard, brand and model. We will pass this 
information on to Smith Micro for consideration in a future version. Use the client that came with your 
device if you have this issue. Also please be aware that Verizon Wireless does not support problems 
associated with Wi-Fi networks. Customer Care will not be able to assist you.  

Wi-Fi Statistics Support Tool 
From VZAccess Manager's main screen select "Session," "Statistics," then the Wi-Fi tab. 

  

 
  

This tool displays signal strength, all relevant IP address information with additional details by selecting "Details." It 
also provides the ability to release your existing IP address and request a new one by selecting "Release," then 
"Renew." This procedure is a common troubleshooting step as explained in some of the symptoms and solutions 
listed above. 

The "Details. . ." option will display the following information:  
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Product Specification 

Technical specification 
This section outlines the technical and environmental specifications of your V640 ExpressCard 

TABLE 1 

Name: Verizon Wireless V640 ExpressCard 

Model: V640 ExpressCard 

Approvals: 

FCC (North America);  

Dimensions: Length: 112mm, Width: 34mm, 
Depth: 5mm 

Wireless Network – Dual 
Mode: 

CDMA 1X/EV-DO 

ExpressCard Standard: ExpressCard 34 

TABLE 2 

Technology: CDMA 

Band Designation: 1X/EV-DO: 800/1900 MHz 

Transmit Band: 824.7-848.31MHz/1851.25-1908.75MHz 

Receive Band: 869.7-893.31MHz/1931.25-1988.75MHz 

Power Output – 
Transmit Power: 

23.8dBm nominal Output Power 

TABLE 3 

Operating Temperature 0° Celsius to +55° Celsius 

Storage Temperature -20° Celsius to +65° Celsius 

Relative Humidity 95% maximum – Non Condensing 

Vibration 147 m/s2 (15Gpeak) 10hz-2000hz 
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Safety and regulations 
This section will inform you of the important safety measures you should be aware, including the standards that the 
modem complies to. 

Wireless communications 
IMPORTANT NOTICE 
Due to the transmission and reception properties of wireless communications, data can occasionally be lost or 
delayed.  This can be due to the variation in radio signal strength that results from changes in the characteristics of 
the radio transmission path.  Although data loss is rare, the environment where you operate the modem may 
adversely affect communications. 

Variations in radio signal strength are referred to as fading.  Fading is caused by several different factors including 
signal reflection, the ionosphere, and interference from other radio channels.  

Novatel Wireless or its partners will not be held responsible for damages of any kind resulting from the delays or 
errors in data transmitted or received with the Verizon Wireless V640 ExpressCard, or failure of the Verizon Wireless 
V640 ExpressCard to transmit or receive such data 

Safety Hazards 
Do not operate the Verizon Wireless V640 ExpressCard in an environment that may be susceptible to radio 
interference resulting in danger specifically; 

Areas where prohibited by the law 
o Follow any special rules and regulations and obey all signs and notices. Always turn off the host device 

and remove the modem from the card slot when instructed to do so, or when you suspect that it may 
cause interference or danger. 

Where explosive atmospheres may be present 
o Do not operate your modem in any area where a potentially explosive atmosphere may exist. Sparks in 

such areas could cause an explosion or fire resulting in bodily injury or even death. Be aware and 
comply with all signs and instructions. 

o Users are advised not to operate the modem while at a refuelling point or service station. Users are 
reminded to observe restrictions on the use of radio equipment in fuel depots (fuel storage and 
distribution areas), chemical plants or where blasting operations are in progress.  

o Areas with a potentially explosive atmosphere are often but not always clearly marked. Potential 
locations can include gas stations, below deck on boats, chemical transfer or storage facilities, vehicles 
using liquefied petroleum gas (such as propane or butane), areas where the air contains chemicals or 
particles, such as grain, dust or metal powders, and any other area where you would normally be 
advised to turn off your vehicle engine. 

Near Medical and life support equipment 
o Do not operate your modem in any area where medical equipment, life support equipment, or near any 

equipment that may be susceptible to any form of radio interference. In such areas, the host 
communications device must be turned off. The modem may transmit signals that could interfere with 
this equipment. 

  
On an aircraft, either on the ground or airborne 

o In addition to FAA requirements, many airline regulations state that you must suspend wireless 
operations before boarding an airplane. Please ensure that the host device is turned off and your modem 
is removed from the card slot prior to boarding aircraft in order to comply with these regulations. The 
modem can transmit signals that could interfere with various onboard systems and controls. 
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While operating a vehicle 
o The driver or operator of any vehicle should not operate a wireless data device while in control of a 

vehicle. Doing so will detract from the driver or operator's control and operation of that vehicle. In some 
countries, operating such communications devices while in control of a vehicle is an offence. 

Electrostatic Discharge (ESD) 
o Electrical and electronic devices are sensitive to electrostatic discharge (ESD).  The VZAccess Manager 

software will attempt to re-initialize the device should a substantial electrostatic discharge reset the 
device.  If the software is not operational after an ESD occurrence, then restart VZAccess Manager.  See 
section 2.1.4. 
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Regulatory notices 

Federal Communications Commission Notice (FCC -- United States) 
Electronic devices, including computers and wireless modems, generate RF energy incidental to 
their intended function and are therefore subject to FCC rules and regulations.  

This equipment has been tested to, and found to be within the acceptable limits for a Class B 
digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide 

reasonable protection against harmful interference when the equipment is operated in a residential environment. This 
equipment generates radio frequency energy and is designed for use in accordance with the manufacturer’s user 
manual. However, there is no guarantee that interference will not occur in any particular installation. If this equipment 
causes harmful interference to radio or television reception, which can be determined by turning the equipment off 
and on, you are encouraged to try to correct the interference by one or more of the following measures:  

Reorient or relocate the receiving antenna  
Increase the separation between the equipment and the receiver  
Connect the equipment into an outlet on a circuit different from that to which the receiver is connected 
Consult the dealer or an experienced radio/television technician for help 

This device complies with Part 15 of the Federal Communications Commission (FCC) Rules. Operation is subject to 
the following two conditions: 

1. This device may not cause harmful interference.  
2. This device must accept any interference received, including interference that may cause undesired 

operation.  
WARNING: DO NOT ATTEMPT TO SERVICE THE WIRELESS COMMUNICATION DEVICE YOURSELF. SUCH 
ACTION MAY VOID THE WARRANTY. THE V640 EXPRESSCARD MODEM OEM IS FACTORY TUNED. NO 
CUSTOMER CALIBRATION OR TUNING IS REQUIRED. CONTACT VERIZON WIRELESS TECHNICAL 
SUPPORT FOR INFORMATION ABOUT SERVICING YOUR WIRELESS COMMUNICATION DEVICE. 

FCC CAUTION: Any changes or modification not expressly approved by the party responsible for compliance could 
void the user’s authority to operate this equipment.  

MODIFICATIONS: The FCC requires that you be notified that any changes or modifications made to this device that 
are not expressly approved by Verizon Wireless, Inc. may void your authority to operate the equipment. 

RF Exposure/Specific Absorption Rate (SAR) Information 
This product has been evaluated for SAR and meets the FCC Guidelines for exposure to radio waves. 

FCC Equipment Authorization ID: PKRNVWXV620 

Your wireless modem is a radio transmitter and receiver. It is designed and manufactured not to exceed the 
exposure limits for radio frequency (RF) energy set by the Federal Communications Commission (FCC) of the U.S. 
Government. These limits are part of comprehensive guidelines and establish permitted levels of RF energy for the 
general population. The guidelines are based on standards that were developed by independent scientific 
organizations through periodic and thorough evaluation of scientific studies. The standards include a substantial 
safety margin designed to assure the safety of all persons, regardless of age and health. 

The exposure standard for wireless devices including mobile ExpressCards and wireless modems uses a unit of 
measurement known as the Specific Absorption Rate, or SAR. Tests for SAR are conducted using standard 
operating positions reviewed by the FCC with the device under test transmitting at its highest certified power level in 
all frequency bands. Although the SAR is determined at the highest certified power level, the actual SAR level of the 
ExpressCard or modem while operating can be well below the maximum value. This is because the ExpressCard or 
modem is designed to operate at multiple power levels so as to use only the power required to reach the network. In 
general, the closer you are to a wireless base station antenna, the lower the power output. 
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Before this device is made available for sale to the public, it must be tested and certified to the FCC that it does not 
exceed the limit established by the government-adopted requirement for safe exposure. The tests are performed in 
positions and locations (for example, at the ear or worn on the body) as required by the FCC for each model.  
THE FCC HAS GRANTED AN EQUIPMENT AUTHORIZATION FOR THIS WIRELESS MODEM WITH ALL 
REPORTED SAR LEVELS EVALUATED AS IN COMPLIANCE WITH THE FCC RF EXPOSURE GUIDELINES.  
THE HIGHEST SAR VALUE FOR THIS MODEM WHEN TESTED FOR COMPLIANCE AGAINST FCC 
STANDARDS WAS 1.14W/KG USER-LAP POSITION AND 0.163W/KG BYSTANDER POSITION.  
 
THIS DEVICE WAS TESTED FOR SAR COMPLIANCE IN THE BYSTANDER CONFIGURATION WITH A 2.5CM 
SPACING.  IN ORDER TO    COMPLY WITH FCC RF EXPOSURE REQUIREMENTS, BYSTANDERS SHOULD 
MAINTAIN A 2.5CM DISTANCE FROM THE ANTENNA OF THIS DEVICE. 
 
THIS DEVICE IS INTENDED TO BE USED IN NOTEBOOK COMPUTERS.  USE IN OTHER TYPES OF HOST 
UNITS SUCH AS PDA’S, ETC, ARE PROHIBITED AND MAY NOT COMPLY WITH FCC RF EXPOSURE 
GUIDELINES/REQUIREMENTS. 
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Limited Warranty and Liability 
Warranty Period: Products & Accessories - 90 days (in each case from the date of invoice).  

Novatel Wireless warrants that during the Warranty Period the Product will be free from defects in material and 
workmanship under normal use. 

THESE WARRANTIES ARE EXPRESSLY IN LIEU OF ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, 
INCLUDING, WITHOUT LIMITATION, ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE. 

NOVATEL WIRELESS’ LIABILITY HERE UNDER IS EXPRESSLY LIMITED TO REFUND OF ALL AMOUNTS PAID 
TO NOVATEL WIRELESS FOR ANY DEFECTIVE UNITS OF PRODUCT, WHETHER NOVATEL WIRELESS’ 
LIABILITY ARISES FROM ANY BREACH OF EXPRESS WARRANTY, REACH OF ANY OBLIGATION ARISING 
FROM BREACH OF WARRANTY, OR OTHERWISE WITH RESPECT TO THE MANUFACTURE AND SALE OF 
ANY UNITS OF THE PRODUCT, WHETHER LIABILITY IS ASSERTED IN CONTRACT OR TORT, INCLUDING 
NEGLIGENCE AND STRICT PRODUCT LIABILITY.  NOVATEL WIRELESS SHALL IN NO EVENT BE LIABLE FOR 
SPECIAL, INDIRECT, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OF ANY KIND OR NATURE DUE TO ANY 
CAUSE. 

Purchaser's exclusive remedy for a claim under this warranty shall be limited to the repair or replacement, at Novatel 
Wireless' option, of defective or nonconforming materials, parts or components. The foregoing warranties do not 
extend to:  

(I) non-conformities, defects or errors in the Products due to accident, abuse, misuse or negligent use of the 
Products or use in other than a normal and customary manner, environmental conditions not conforming to Novatel 
Wireless' specification, of failure to follow prescribed installation, operating and maintenance procedures,  

(II) defects, errors or nonconformities in the Product due to modifications, alterations, additions or changes not made 
in accordance with Novatel Wireless' specifications or authorized by Novatel Wireless,  

(III) normal wear and tear, 

(IV) damage caused by force of nature or act of any third person,  

(V) shipping damage,  

(VI) service or repair of Product by the Purchaser without prior written consent from Novatel Wireless,  

(VII) Products designated by Novatel Wireless as beta site test samples, experimental, developmental, reproduction, 
sample, incomplete or out of specification Products, or 

(VIII) returned Products if the original identification marks have been removed or altered. 
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Glossary 

1xRTT 
Short for single carrier (1x) Radio Transmission Technology. A high speed wireless technology based on the CDMA 
platform. 1xRTT has the capability of providing broadband-like speeds of up to 144 Kbps.  1xRTT is also referred to 
as CDMA2000. 

1xEVDO 
Part of a family of CDMA2000 1x digital wireless standards. 1xEVDO is a "3G" standard. EVDO stands for 
"EVolution, Data-Optimized."  1xEVDO is based on a technology initially known as "HDR" (High Data Rate) or 
"HRPD" (High Rate Packet Data), developed by Qualcomm. The international standard is known as IS-856.  
1xEVDO has the capability of providing broadband-like speeds of average speeds of 400-700 kbps.   

Access Point 
An interface between a Wi-Fi network and a wired network. 

bps 
Bits per second – rate of data flow. 

Broadband 
High-capacity high-speed, transmission channel with a wider bandwidth than conventional copper teleExpressCard 
lines. Broadband channels can carry video, voice, and data simultaneously. 

COM Port 
Defines a serial/RS-232 port within the Windows environment.  May be physical or virtual. 

Dial-Up Connection 
A switched network connection established by a computer using an analog data modem over ordinary copper 
telephone lines. 

Dormancy 
A network state that occurs when no data has been transmitted or received after a given amount of time.  A network 
connection may disconnect during a dormant state. 

ExpressCard 
A new standard introduced by PCMCIA that delivers thinner, faster, lighter devices to desktop and notebook 
computers. All ExpressCard slots accommodate devices that support USB 2.0 or PCI Express Standards. 

Firewall 
A hardware or software boundary that protects a network or single PC from unwanted outside traffic.   

HTTP 
Hypertext Transfer Protocol 

ISP 
Internet Service Provider 
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IP 
Internet Protocol.  The mechanism by which packets are routed between computers on a network. 

Kilobyte 
1024 bytes 

Kbps 
Kilobits per second – rate of data flow 

LSP 
Layered Service Provider – a Microsoft feature 

LAN 
Local Area Network.  A data network confined to limited area with moderate to high data rates.  Does not use 
common carrier circuits, although may have gateways or bridges to other public or private networks. 

Mbps 

Megabits per second 

PC 
Personal Computer 

PCMCIA 
Personal Computer Memory Card International Association.  Defines specifications used for ExpressCards.   
www.pcmcia.org 

PDA 
Personal Digital Assistant.  A handheld device used for organization, notes, address books, etc. 

POP3 
Post Office Protocol v3.  A standard transport protocol used send and receive email. 

Proxy 
A firewall mechanism that replaces the IP address of a host on the internal (protected) network with its own IP 
address for all traffic passing through it. 

Serial Connection 
A network connection established by a serial device such as a modem.  Serial communication between your PC and 
modem or other serial devices adhere to the RS-232 standard. 

SMS 
Short Messaging Service.  Short text messages of generally no more than 140-160 characters sent and received by 
wireless devices. 

SSID 
Service Set Identifier. An SSID is also referred to as a Network Name because it is a name that identifies a Wi-Fi 
network.  Most access points broadcast their SSID. 
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Sync 
To compare and synchronize two or more sources of data.   

TCP/IP 
Transmission Control Protocol / Internet Protocol 

URL 
Uniform Resource Locator 

USB 
Universal Serial Bus.  A connection type for computer peripherals such as a printer, mobile ExpressCard, etc. 

VPN 
Virtual Private Network.  A way to communicate through a dedicated server securely to a corporate network over the 
Internet. 

WAN 
Wide Area Network.  A network which uses common carrier-provided lines.  Contrasts with LAN. 

WCDMA 
Wideband Code Division Multiple Access. Wideband CDMA is a third-genTeration (3G) wireless standard which 
utilizes one 5 MHz channel for both voice and data, initially offering data speeds up to 384 Kbps. WCDMA is also 
referred to as UMTS - the two terms have become interchangeable. WCDMA is the 3G standard that most GSM 
carriers are moving to. Parts of the WCDMA standard are based on GSM technology. WCDMA networks are 
designed to integrate with GSM networks at certain levels. Most WCDMA ExpressCards include GSM as well, for 
backward compatibility. WCDMA borrows certain technology ideas from CDMA, as the name implies, but is in fact 
very different and incompatible with ExpressCards and networks using "CDMA" technology. In Europe and Asia, 
WCDMA is being deployed in the all-new 2100 MHz frequency band. In North America, WCDMA is being deployed in 
the existing 1900 MHz (PCS) and 850 MHz (cellular) bands. 

WEP 
Wired Equivalent Privacy.  A security protocol for wireless local area networks (WLANs) defined in the 802.11b 
standard. WEP is designed to provide the same level of security as that of a wired LAN. 

Wi-Fi 
Wireless Fidelity.  A generic term used to describe any type of 802.11 (a, b, g) network. 

WWAN 
Wireless Wide Area Network 

WWAN Device 

Wireless ExpressCard and cable or 1xEVDO/1xRTT/CDMA ExpressCard. 

WWW 
World Wide Web 
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Trademarks and Service Marks 
Verizon Wireless is a trademark of Verizon Trademark Services LLC, and the other trademarks, logos, and service 
marks (collectively the "Trademarks") used in this help file are the property of Verizon Wireless or their respective 
owners. Nothing contained in this help file should be construed as granting by implication, estoppel, or otherwise, a 
license or right of use of Verizon Wireless or any other Trademark displayed in this help file without the written 
permission of Verizon Wireless or its respective owner.  

VZAccessSM is a service mark of Verizon Wireless 

Microsoft®, Hotmail®, MSN®, ActiveSync®, Outlook®, Outlook Express® and Windows® are either registered 
trademarks or trademarks of Microsoft® Corporation in the United States and/or other countries. 

Netscape and the Netscape N and Ship's Wheel logos are registered trademarks of Netscape Communications 
Corporation in the U.S. and other countries.  

AOL® is a registered trademark of America Online, Inc 

Aironet® , Cisco®, Cisco Systems® are registered trademarks of Cisco Systems, Inc. and/or its affiliates in the U.S. 
and certain other countries. 

HotSync® is a registered trademark of Palm, Inc. 

The names of actual companies and products mentioned in this help file may be the trademarks of their respective 
owners. 

Contents of this help file, Copyright 2006 Verizon Wireless, all rights reserved.  

PN GU-90023964 Version 1.0 JUN2006  
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